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About Allegro Design Flow Integration

This chapter introduces the Allegro Design Flow Integration (Allegro DFI) tool, discusses its benefits and provides an
overview of the process used by Allegro DFI to take selected layout information from a design in Allegro and export it
to ADS; where it can be used to run a physical simulation. Please note, the Allegro DFI tool is not intended to provide
complete layout transfer from Allegro to ADS.

Allegro Design Flow Integration Overview

The Allegro Design Flow Integration (Allegro DFI) is an add-on to the Cadence Simulation tool. This tool is used to
export layout information defined in Allegro into ADS where the Momentum simulator can be used to simulate the
EM-behavior of the selected section of the layout. The Allegro DFI tool enables you to select specific "nets" and board
layers from a user specified area of the layout. Using the cookie cutter feature you can "cut" this section of the layout
from the design and save it in EGS format, along with the cross section description of the vertical stack. Using Ports
option tab, Allegro DFI enables you to automatically, or manually place ports on the signal trace pads and clear all
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exsisting ports.

Supported Operating Systems

For information on supported operating systems refer to your Cadence Allegro documentation or the Cadence website
at:
http://www.cadence.com

Accessing the Documentation

Allegro DFI documentation cannot be accessed from within the Allegro PCB editor. To access Allegro DFI
documentation you must either:

e Open ADS, then from any ADS window select Help > Topics and Index > Translation, I/O & Connected Solutions
> Allegro Design Flow Integration.

e Go to the Agilent EEsof EDA website:
http://eesof.tm.agilent.com/]
Select Product Documentation > Advanced Design System (ADS) > 2006 Update 2 .

Allegro Design Flow Integration Use Model

The following diagram outlines the process flow for the Allegro Design Flow Integration tool:


http://www.cadence.com
http://eesof.tm.agilent.com/
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How to Install the Allegro DFI Tool

The Allegro Design Flow Integration tool (Export To ADS) is an add-on utility integrated into the Cadence Allegro PCB
editor. In order for Allegro DFI to be available in the PCB editor you must modifiy some of PCB editor startup files. The
procedure to do this is described in the following section.

© Note

A design kit, which must be installed in ADS, is also provided to enable you to easily import the exported files.
Refer to the Design Kit Installation and Setup] for more information on installing design kits in ADS.

The files needed to install Export To ADS can be found in your local ADS installtion directory under either
%HPEESOF_DIR%/ial or $HPEESOF_DIR/ial .

A text version of these instructions is also located there under the name:

INSTALL

This file can be opened with any text editor.

) Note

HPEESOF_DIR is an environment variable pointing to the head of the ADS installation tree.

To add the Export To ADS menu components to the Allegro PCB editor's main menu, you will first need to modify the
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Allegro menufile.

 Note

An example of the popup menu to be added to the Allegro main menu can be found at:
$HPEESOF_DIR/ial/config/eemMenuFrag.men

Please note, if you need to change the menu location from < allegro_install_path > /share/local/pcb/menus to another
directory, you can do so by:

1. Modifying the MENUPATH Allegro variable to include the new directory.
2. Selecting select Setup > User Preferences... from the Allegro PCB Design main menu and adding the directory to
where the menufile resides to the Ui_paths menupath.

Ak POB Design K12 ods_reated1.brd Praject: Ei... Aesamglenlbsard_devign CE&

e Menfsoas Took oot To A esn

@ g o e a¥ | dy i ® 4| um
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1. Adding the following line to your allegro.ilinit file:

(set Shel | EnvVar " EEMOM MENUPATH=<di r ect or yWher eMenuf i | eResi des>")

In this case, if a menufile resides in the working directory and that working directory is first directory in Allegro's
MENUPATH , then that file will be used.

Adding the Export To ADS Menu Pick to the Allegro PCB Editor Menu

To install the Export To ADS components:

1. Copy <allegro_install_path>/share/pcb/text/cuimenus/allgero.men or the menufile you are currently using to:
<allegro_install_path>/share/local/pcb/menus
a. Open allegro.men in a text editor.
b. Add the contents of:
$HPEESOF_DIR/ial/config/eemMenuFrag.men to this file just before the entry POPUP "&Help" .
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U sty |
c. Save the file.
2. Modify the Allegro PCB editor initialization files to load the ADS integration context file and set its parameters.

 Note

You must use "/ "as a path delimiter inside the Allegro configuration files!
"~/" translates to % HOME%_ in Windows and _$HOME/ in Linux

a. Go to ~/pcbenv and locate the file allegro.ilinit .
b. Open allegro.ilinit in a text editor.

 Note

Create this file if it does not exist.

c. If HPEESOF_DIR is not already an environment variable, add the following line to this file:

(set Shel | EnvVar "HPEESOF_DI R=<path to root of ADS installation>")

e You may optionally add the following lines:

(set Shel | EnvVar "EEMOM SKI LL_DI R=<pat hToWher eEenonCt xResi des>")

This directs the interface to the skill context file that provides export functionality. By default, it looks in
$HPEESOF_DIR/ial/skill/15.7

(set Shel | EnvVar " EEMOM GLOBALOPTI ONSFI LE=<pat hToWher el t Resi des>/ eenom opti on")

This directs the interface to the global export options file used to populate the setup settings. The default
is:
$HPEESOF_DIR/ial/config/eemom.option

 Note

The contents of the optional files $HOME/pcbenv/eemom.option and < currentWorkingDir >/< currentDesign >
.option will be added to the setup settings.

## Add the line:

(1 oad "<dirContainingSkilllniFile>eemmini")
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This auto-loads the Export To ADS context file when the Allegro PCB editor starts.
The shipped version is:

$HPEESOF_DIR/ial/skill/15.7/eemom.ini

The above line can be modified to read:

(load (sprintf nil "%/ial/skill/15.7/ eemomini" (getShell EnvVar "HPEESOF_DI R')))

3. Open the Allegro PCB editor , the " Export To ADS " menu item should be available in the main menubar, as
shown in the following illustration.

* - Allegro PCB Design XL: unnamed.brd Project: F:/Cadence/default
File Edit Wiew aAdd Display Setup Shape Logic Place Rodte  Analyze Manufacture Tools BSNGGEGEEN Help

= X « = AR Q| a g« EH (HETT e

Select Traces ...

L Mr A > 4 E® BECOCDOWwW.L Expart

' ’
L Shate ] ’afFind\f\.fisibility\

Active Clazs and Subclazs

R SR Board Geomety 3

.................................................... D |:| Outlire a

Fomentum Allegro Integration [Version 2.0.0) | Bcmd: 1dle

Starting new drawing. .. .
Grids are drawn 40000, 400.0 apart for enhanced viewabilibg, [P [&] 182000, 16300.0

Mew databaze opened: "F./Cadence/default/unnamed.brd"
Command »

If not, check the Allegro configuration and Ui menu path to ensure that the directory where your updated allegro.men
file is stored, is in the front of the path; if not, modify this file.
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To do this, select Setup > User Preferences > Ui _ paths and click the menupath: button located in the Value column.

Categony:  Li_paths

FPreference Yalue Effective
formpath: C] Resztart
menupath; C] Feztart
prieditpath: C] Festart

Using the Allegro DFI Tool

To open Allegro DFI select Export to ADS from Allegro PCB main menu.
This opens the Export to ADS drop-down menu.

Export To ADS

Setup ...
Select Traces ...

Expork 4

Skake 4

Setting Up and Configuring "Export To ADS"

The following selections are available in Export To ADS : Setup , Select Traces, Export and State .

Setup...

Selecting Setup... opens the Set Up for Momentum dialog:

11



Advanced Design System 2008

B Set Up for Momentum

Export Options

Export Setting | [EENIERERERSTE S Til=|

Selection Description

Signal viaType aszDefined. padTvpe aszlefined
Ground viaType aszDefined. padTvype azDefined
Signal and Ground arcResolution 15 degreess=

Re=zet-reload All Eeload Options= l [ ()4 ] [ Cancel

This dialog is used to set up options for exporting files to ADS.

Sample Export Settings

The default Export Setting drop-down menu offers 3 different sample settings for export:

Sample Fine Setting
Sample Medium Setting
Sample Course Setting

B Set Up for Momentum

Export Options
Export Setting |Sample Coars=e Setting w

Selection Desc Samnple Medium Setting

Signal viaTyplSample Cosrse Setting
Ground viaType diamond, padlvpe dianond
Signal and Ground arcResolution 45 degrees

Simplify thermal wia connections

Remove unconnected catch pads

Remove woids in RF Ground Shapes that do not overlap Signals

Feset-reload All Reload Options ] [ QK ] [ Cancel

 Note

You can modify these settings and/or add as many custom settings as you want. To do this you must open and
modify the eemom.option file. For more information on locating and modifying this file refer to, Export to ADS

12
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Settings".

Sample Fine Setting

This setting has the following default values.

¢ Signal viaType asDefined, padType asDefined
e Ground viaType asDefined, padType asDefined
¢ Signal and Ground arcResolution 15 degrees

Sample Medium Setting

This setting has the following default values.

e Signal viaType square, padType square
e Ground viaType square, padType square
e Signal and Ground arcResolution 30 degrees

Sample Course Setting

This setting has the following default values.

e Signal viaType diamond, padType diamond

e Ground viaType diamond, padType diamond

¢ Signal and Ground arcResolution 45 degrees

e Remove unconnented catch pads

e Simplify thermal via connections

e Remove voids in RF ground shapes that do not overlap signals
The Setup dialog also offers two addtional options:

Reset/Reload All

selecting this button enables you to reinitialze the initial option configuration files for Export To ADS in the Allegro
enviroment, should that become necessary.

Reload Options

13
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If a setting is changed, selecting this button enables you to load new or update option configuration files, without
reloading Allegro.

Selecting a Specific Geometry and Placing Ports

Choose Export to ADS > Select Traces to open the Select Geometry and Place Ports dialog. This dialog enables you to
choose specific nets and add them to Signal and Ground output lists for export into ADS, by using the Trace Select
and Layer Select tabs.

It also enables you to reduce the geometry of the ground nets by using the functions available in the Cookie Cutter
tab to define a "cutout" shape. Using the cookie cutter, you can reduce the stack of the board, select which layers will
be exported and create port definitions for export into ADS.

) Note

The cookie cutter feature does not alter the shape of the signal nets.

The Port tab enables you to automatically place ports on the signal trace pads, or clear all exsisting ports.
A visual status check is also provided to alert you that a step is complete and ready for export (green), or that more
information is required (yellow).

14
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B Select Geometry and Place Ports

1 Trace Select | 2) Layer Select | 3] Cookie Cutter | 4) Parts

Selectable Met Pool Signal Mets

&dd -»

<- Remove

add Al -

<- Remaowve All

RF Ground Hets

&dd -»

<- Remove

Add Al -

<- Remowve all

(%) All Available Mets
7 Pick Mets

] Filter Mets with wildzards

|

1) Traces Not Ready  EJESpSrERESdy 3 Cutter Mot Feady 4] Parts Mat Fleady

[ aF. ] [ Canicel

Using the Trace Select Tab

The Trace Select tab enables you to add specific nets to the Signal Nets and RF Ground Nets output lists.
You can select nets for export can by choosing specific nets from the Selectable Net Pool and clicking the Add button

15
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in the Signal Nets section of the dialog, as shown below. The Nets selected in the list will appear as highlighted traces
in the design.

Gugnal Mty

CLE1

dubd 3 LR
CLi2

G
(- Formve | CLETe
.| CLE3-
AddEd CLESs
CLis

[1}v]
nn
L ¥

= A8 vadsbies Mats
Fick Hiets

1] Filtm Mot vty 'wiide ety

There are 2 ways to populate the Selectable Net Pool.

1. By selecting the radial button labeled All Available Nets located below the Selectable Net Pool window.
2. By picking specific nets from the Layout window.

To pick specific nets from the Layout window, select the Pick Nets radial button and zoom in on the area of interest.
Next, click the specific net or nets you wish to add to the Signal Nets list.

The selected traces are highlighted in the design and appear in the Selectable Net Pool , as shown in the Nets selected
from the Layout window.
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O AN Ay aeilahin Bty

(=) Pack Mets

End | b
I

Nets selected from the Layout window

Optionally, you can filter the selectable nets displayed in the selectable nets list by clicking the Filter Nets with
Wildcards check-box and providing a filter pattern, as shown in Selecting nets using a wildcard. Pressing Enter on your
keyboard implements your selection and populates the Selectable Net Pool .

 Note

This feature is only available when the All Available Nets radial button is active.

17
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Selectable Met Pool

CLE2
CLE1+
CLEA-
CLEZ+
CLEZ-
CLE3+
CLE3-
CLEA4+
CLEA-

o) &l dvailable Nets
) Pick Nets

[+] Filter Mets with wildcards
CLE®

Selecting nets using a wildcard

Selecting RF Ground Nets

RF Ground Nets can be selected using the same steps required to select signal nets; selecting the nets from the list of
all available nets, or by picking specific nets from the Layout window.

18
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1) Trace Select | 2] Layer Select | 3] Cookie Cutter | 4] Ports

Selectable Met Pool Sigral Mets

015 .
DATAD Add -
DaTAl
DATAZ
DAaTAS
DaTA4
DATAR Add Al -»
DATAR
Bi¥ig <- Remowve Al
DaTAS

DATATD

DaTAT

DaTATZ RF Ground Mets
DATATZ

DATAa14 Add - WEL
DATATR

HLD <- Remove
=500
k_I0

PELE Add Al -»
Fan
R <- Remowve Al
Rz

Fas

R&d

£ >

<- Remove

(&) &l dvveailable Mets
) Pick Mets

[ Filter Mets with “fildzards

|

Selecting RF Ground Nets

Once the Signal Nets and RF Ground Nets have been selected, the yellow Traces Not Ready status bar is automatically
updated by the green Traces Ready status bar. You are now ready to select layers using the Layer Select tab.

1] Traces Ready Z] Layers Mot Fleady 3] Cutter Mot Feady 4] Portz Mot Beady

Using the Layer Select Tab

19
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This tab enables you to choose the layers that will be exported to ADS. By choosing all the layers found, as shown in
Layer Select Ready, the object will be exported from all layers and no additional infinite ground planes will be defined.

# Select Geometry and Place Ports

11 Trace Select . 2] Laver Select | 3) Cookie Cutter | 4] Ports

Layer Pool Laverz Uzed In Simulation

Infirite Ground Top W

ETCH/TOF
ETCH/GHD
ETCHACC
ETCH/ABOTTOM

&dd -

<- Remove

&dd Al -

<- Remowve all

Infinite Ground Bottom w

1] Traces Ready 2] Layers Ready 3] Cutter Mot Feady 4] Ports Mot Feady

k. ] [ Cancel

Layer Select Ready

20
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To limit the board stack by adding infinite ground planes, choose the layer from the list in the infinite ground top or
bottom dropdown boxes. The metallization patterns on those layers will be replaced by a solid metal layer.

 Note

The layers above Top or below the Bottom infinite ground selections will not be exported to ADS.

The graphic in Example Layer Export List illustrates what will be exported when layers are selected in the Layers List .

As seen in this illustration, only the layers between the ground planes are available for export. Lay 1 (which is above
the top ground plane) and lay 4 (which is below the bottom ground plane) will not be available for export. From the
available list, (lay 2, lay 3) only lay 2 was selected. Therefore, only the shapes located on lay 2 will be exported.

Layer List
haginal laper slack Layer Bebecl dlabag Expari=d bayar slack
lay 1 I

Wy Goesl fon = by lgm
lay [ gna —_—— - — - — - —

reneaeas anly By il o axpewoo A05 wil
bay 2 I lay Zzelecl=a peespoc o 005 |- Fack 0 005 ]
lay 1 I I [lay 1 nal selecl=d)
by [ W e e B —
iy Gioenl Emioe = by 1z
by 4 —_ i Wome: Onby Cne ananss on kw2 el oe oo ed

Example Layer Export List

Using the Cookie Cutter Tab

This tab enables you to limit the exported area to an area that only contains the signal traces of interest.

21
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B Select Geometry and Place Ports

1) Trace Select | 2] Layer Select 3] Cockie Cutter | 4) Parts

Build Cookie Cutter

Clear Clear existing cookie cutter palygaon

Build Build new cookie cutter palygon around zignal races

Ewpanzion diztance [MIL] 5000

Edit Cookie Cutter

Move vertices and sides

v Click cutter polwgon ba ztart, ight click Done o finizk

E dit boundany by drawing new sidesz

Edit Click cutter polwgon to start, nght click Done to finizh

_ _ 3] Cutter Hot Ready 4] Parts Mot Ready

QF. ] [ Cancel

Cookie Cutter Tab

Building a Cookie Cutter

22
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Using the Build Cookie Cutter section you can:

¢ Clear an existing cookie cutter polygon
e Build a new cookie cutter polygon around the selected signal traces
e Set the expansion distance

Setting the Expansion distance and clicking Build auto-generates a cookie cutter polygon around the selected signal
nets. The cutter polygon will be visible on a scratch layer of the design and the first status indicators turn green.

© Note

The Cookie Cutter only cuts metal on the RF ground nets. It does not cut metal on the signal nets.

If the autoshape is correct, click OK , to dismiss the dialog.

o M=

T R s = | Baaaqw gy o= 0| am

EXASLLEE: e - BEO00OWM=

Auto-generated cookie cutter.

Editing the Cookie Cutter

The Edit Cookie Cutter section enables you to alter the shape of the cookie cutter polygon by using one of 2 methods:

23
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Edit Cookie Cutter

Move vertices and sides

| b ove | Click. cutter polvgon to ztart, right click Done ta finizh

Edit boundary by drawing new zides

| Edit | Click, cutter polygon to start, right click Done ta finizh

Move vertices and sides

Once built, the cookie cutter polygon shape can be altered using this feature.

1. Click Move and select the cookie cutter polygon in the Layout window using a left click of the mouse.

This highlights the polygon and the nodes located at the vertices.

 Note

If the wrong shape is selected (highlighted area), click the right mouse button and select Reject from the
pop-up menu.

In the Reject item selection window, select the item on the scratch layer (by default Manufacturing /
Eem_Scratch ).

1. Select a point on the cutter shape, either a side (line segment) or vertex (node), click and hold the left mouse
button: To move the selected object, scroll the mouse to the desired location and release the button.

24
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2. When finished, use a right mouse click inside the Layout window and click Done .

Editing the Boundary by Drawing New Sides

The Edit boundry by drawing new sides option enables you to edit the cookie cutter polygon by drawing new lines to
reshape it.

1. Click Edit and select the cookie cutter polygon in the Layout window using a left mouse click.
If the wrong shape is selected, right click the mouse and select Cancel .

Done Fz
Cancel F4
Tlexk Chrl+F2
fatg

Toggle

If you have difficulty selecting the cutter shape (located on the scratch layer: by default Manufacturing / Eem_Scratch
) you can use the Visibility tab in the Allegro Layout window to turn off layers overlapping the shape, as seen in
Overlapping Layers "Turned Off" to Highlight Cutter Shape..

25
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[ Options \ [ Find Y [ visibiity \

I L4

L aper Etch Pin Yia Dic Al

Conductors OoOoQdnd
Planes [v] OoOoQdnd

Top o o o W []
Gnd o o ] . []
ce o] o] (] [ [ ]
B ottom o m ] w[]

Overlapping Layers "Turned Off" to Highlight Cutter Shape.

1. Select a point on the polygon using a left mouse click. It can be either a line segment (side) or vertices.

2. Move the mouse to a new location and click again to draw the new line/boundary.

26
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Continue doing this, as necessary, to create the new boundary.
3. To finish drawing the line, reconnect the line to the original polygon cutter shape. The boundary of the cookie
cutter should now include the new area.

e

4. Right click the mouse inside the Layout window and click Done to complete the edit.

Cancel F4
Mexk Chrl+F2
Arc

Toagle

The final step is to add ports to the design.

Using the Ports Tab

27
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The Ports option tab enables you define the ports on your selected nets.

™ Select Geometry and Place Ports

1] Trace Select | 2] Layer Select | 3] Cookie Cutter - 4) Parts

Autoplace Ports

Clear all exizting portz
AutoPlace | Autoplace portz on zsignal race padz

Fort List

| #dd | | Delete | | Edit |

Werify porks

Yerfp/Update | Port werfization and [relrumbenng. Needed

4] Parts Mot Ready

l

OF.

] [ Cancel

Auto Creating Ports
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Selecting AutoPlace enables you to automatically generate a port for every component pin (pad) on the selected
Signal Nets. The result is then visible in the Port List window, as seen in Port List Window.

Fort Lizt

] O O O O O = O O O Y O

¥\ Port 001 :
¥\ Port 002 :
¥\ Port 003 :
¥\ Port 004
¥\ Port 005 :
¥|[C7] Port 005
¥\ Port 007 :
¥\ Port 003 :
v|T) Port 009
v|T Port 010
CCLEZ- U225
VT Port 012
VT Port 013
v|T Port 014
VT Port 015
v|C Port MG

¥|C) Port 011

CLE1+.R21
CLET+ U222
CLET+1231
CLE1-R2.2
CLET- U223
CLET- U232
CLEZ2+.R31
CLE2+ U228
CLEZ2+23.14
CLEZ2-R3.2

CLEZ- U235
CLE3+.R4.1
CLE3+ 2210
CLE3+ U236
CLk3-R4.2

| add | | Delete | | Edit |

Port List Window

You can expand each port definition in the port list to make the properties of a port visible, as shown in Expanded Port
Definition.
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Fort Lizt
[l Port 007 : CLET+.R2.1
& Port number: 001
& Port name: CLET1+R21
& Portimpedance: [30.000 + 0.000] Ok
& Port Tupe: Mon-calibrated
& Deembedding offzet; Mo
+ [0 Positive Reference Ping
+ [0 Megative Reference Pins
[W[[CT) Part 002 CLET+L222
[W]TT Part 003 : CLET+10231
W|T7 Part004: CLET-RZZ2
[W]C Part005: CLET-UZ22.3
[W|[C Part 006 CLET- U232
[T Part 007 : CLEZ2+.R3.1
[W|C] Part 003 CLEZ2+ U226
[T Part 009 CLEZ2+. 2314 “

| #dd | | Delete | | Edt |

I e O o O e S

Expanded Port Definition

When a port is selected, pointer symbols are automatically placed in the layout with the exact positions of the positive
and negative reference pins of that port.
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|
|
|
|
\d

&

&

By using the check box in front of each port you can enable or disable a port for later export. This way you can store
the port definition, if it was heavily modified for later use.

= W= Port 001 CLET+R21
& Port umber: 001
% Port name: CLET+R21
& Port impedance: [50.000 + 0.000] Okm
& Port Type: Mon-zalibrated
& Deembedding offzet; M

The available actions for modifiable pin or port properties are indicated byproperties of a port or a pin that can be
changed will display what actions are allowed, by displaying active ** Add , Delete or Edit buttons. Unselectable or
inactive buttons will be grayed out .
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Fort List

= W= Port 001 : CLE1+R21 E
& Port number: 0071
LB FPort name: CLE1+.R2.1
& Port impedance: [50.000 + 0.000] Ok
& Port Type: Hon-calibrated
& Deembedding offzel; MA
- B= Positive Beference Pins
- = Pir: B2
% Onnet CLET+
% PFin position [wy] = [1200:3240]
% Momentum Fin position [xy] = [1200:3240)
% LaperMame: ETCHA/ABOTTOM
- B= Megative Beference Ping
& Auto detect
+ - [WIC Port 002 : CLET+1122.2
wIC Port 003 : CLE1+UZ231 o

Port Properties

As shown in Port Properties, it is possible to change the Port name because the the Edit button is active/enabled when
that property is selected. However, if Port number is selected, none of the change options are available and all are
grayed out or inactive since the Port number cannot be changed.

Port Properties

Port properties include:

Port numbers :

Port numbers are automatically assigned by the tool. They are consecutive starting from 1 and must be regenerated in
order for a port set definition to be valid.

Port name:

The port name is auto-generated as < net name >.< instance >.< pin nr >. However, this name is modifiable and can
be used to sort automatically generated ports.
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Port impedance:

The default port impedance is 50 Ohms, but this can be modified to meet your specifications.

Port Type:

Only non-calibrated ports are available in this version.

Deembedding offset:

Deembedding distances can not be used in this version.

Positive and Negative reference pins:

Both positive and negative reference pins are available.

= W= Port 001 : CLET+R21

& Port rumber: 007
& Port name: CLE1+R21
& Portimpedance: [50.000 + 0.000] Ohm
& Port Tepe: Mon-calibrated
& Deembedding offzet; Ha,

- = Positive Reference Pins
+ 7 Finc B21

+- [ Megative Reference Fins

Pins are associated to ports as either positive or negative reference pins. These pins have both a standard pin position
(normally the device's pad position) and a momentum pin position that can be modified for better simulation setups.
Pins are also defined to be on a specific metallization layer. However, on multi layer device pins, the layer setting can
be modified to valid simulation layers in the setup.

It is important to note that a port is always defined between a positive and negative reference pin and that both
reference pin types must be manually defined for each port, under normal circumstances. If not, the simulation results
will be wrong. By exception, if some form of infinite ground layer definition exists in the structure, the negative pin will
be omitted. In this case, the Momentum simulator uses an implicitly defined port on the ground layer. Infinite ground
layers can be derived from existing negative plane definitions in Allegro, or by defining them in the Layer Select
window.

Positive reference pins will only appear on the component pins of selected Signal Nets and the negative pins are
normally component pins of an RF Ground Signal . However, the auto generation feature can also use a nearby via or
point pin on a shape that is part of an RF Ground Signal, if it runs out of an RF Ground Signal devices pins that are
close enough. These last point pins have the following naming convention:
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NonDevRefPin<type> <signal> <initial location> .

If an infinite ground is present in the structure the automatic port generate mechanism will rely on the implicit ground
reference pin feature of Momentum and not generate a negative reference pin.

The Momentum pin position can be changed within the area of the shape for which it was defined. To do this, click the
Momentum Pin position : in port properties and select the Edit button. This provides you a coordinate Pick that
enables you to select a new pin position as shown in Momentum Pin Position.

Puart List

= W= Port 007 : CLE1+R2.1 E
& Port number: 001
& Port name: CLE1+.R2.1
& Portimpedance: [50.000 + 0.000] Dhm
& Port Type: Mon-calibrated
& Deembedding offzet: MA
- = Pozitive Reference Pins
- = Pin B21
& Onnet CLET+
& Fin position [ey] = [1200:3240)
LW Momentum Pin position [xy] = [120
& Layer Mame: ETCH/BOTTOM
- = Megative Beference Pins
& Auto detect
+ - [W[C Port 002 : CLE1+1022.2
wI[T] Port 003 : CLET+.U231 o

Give a new Momentum Fin pogsition:

« (120000000000 [3240.00000001

Momentum Pin Position

Using the Apply or Reject buttons enable you to accept the change to the port defintion or cancel it. This also returns
the interface back to the default configuration.

Delete

This button, shown in Deleting a Port, enables you to remove specific pins or port definitions from the list.

© Note

When ports or pins are deleted the component pins become available for manual port and pin placement.
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SR ] ot 00t Lkt A2 | -

Pt ramibeme: 007

b

\

Y

b

& Doernbeddrg offres K
E 4

e Hstsaprece Hy

Il

v w0 Pon @03 CLEN-LZLT

¥ ] Pl 004 CLET FLZZ w

[(asa | [eme | [ Em |

Deleting a Port

Clear

Selecting Clear removes all existing ports.
You should note that whenever you modify the port properties, or change layer definitions you must perform a

Verify/Update to ensure your port definitions are still consistent with the available layer and cookie cutter settings.
This step also assigns consecutive port numbers for export and simulation.

Werify ports

Yerfy/Update | Poart wverfization and [relrumbenng. Needed

 Note

Port numbering must be consecutive for the port state to be valid.

Manual Port Creation

When one or more Signal Net device pins are not associated with any port, it is possible to manually create a port.
Selecting the Add button enables you to create a new port by selecting one of the free Signal Net device pins from the
pin selection interface. The pin can either be selected from the list boxes, or by using the Pick button to select the pin

in the Layout window.
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Define a pozitive reference pin to add a new port
On et v
RefDes. Fin: | R2.1 v

Selecting Apply adds the port into the port list. If a port was already selected in the port list, the new port will be
placed immediately behind that port. If no port was selected, the new port is created at the end of the list.

When possible, the port creation code tries to add an appropriate Negative Reference Pin to the port definition.

Manual Pin Association

It is possible to use manual pin association if you wish to add more Negative Reference pins, or when more complex
ports must be created with multiple grouped pins (either Positive or Negative Reference pins).

In order to do this, select in the port's definition in the Port List , the Positive or Negative Reference Pins tag and

select the Add button, this opens the pin select interface . Next, select the Net in the Select window and find the pin
name that you wish to add.

Add a negative reference pin to port Pick.
On Met; WICC w Feject
RefDes. Pine | C121 “ Apply

A Pick capability is activated enabling you to select Signal Net component pins for Positive Reference pins, RF Ground
Net and Signal Net component pins for Negative Reference pins.

For Negative Reference pins you can also create non device point pins by selecting the Non Device Reference Pin
option and using the Pick button. You can then place a pin anywhere on the selected net.

 Note

No validity checks are performed when you place the pin.

A NonDevRefPin..._ will be created when a valid position was picked.
Use Apply or Reject to make or drop the changes to the port definition.

Creating a Negative Reference Pin
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In certain situations (e.g., where only finite positive shapes are available), it may be necessary to manually add a
negative reference pin to a port.
To do this:

1. Select a port and open the tree view to see the list of properties and pins associated with it.

WP Pot O : CLET+R21
& Port resnber 001
& Port name: CLET= A2
& Port mpedancs (50000 «f 0 000) Ok
& Port Typer Norvcalbeated
& Doertbeddng ofced Ha
# 3 Postree Refeence Pra
# 23 Megatire Relererce Fro

2. Select Negative Reference Pins , open the tree view and choose Add , as shown in Allegro Design Flow

Integration#1148991.
lallegrolink-2-1-42.gif!

3. In the Add a negative reference pin to port section, select GND from the dropdown list of available nets and Non
Device Ref. Pin from the RefDes Pin: dropdown list.

|- Post List
| = WP Port 00 CLE1+ A2 -
& Poi ruaber. G0
% Port name: CLE1+ A2
& Pod mpedarce: (50000 « 0.000) O
@ Port Type: Norrcsitested
& Desmbeddng ofizet HA
# [ Postres Retererce Fins
= P Megatrin Rabeence Pra
& Ao detect
¥ Pt 002 CLKT+ U221
“D Fogt 003 CLET-R22
¥ Port D04 CLET-LIZE2
“D Peet (05 - CLEZ= R
| Port 006 CLEZs U226
(=] Port D07« CLE2e U314
Vi) Pod 008 CLE2-RIZ

L
Audd 8 negatnie rebsence pan bo port
Or Mt GHD “

RedDes. Pirc b

s s ®

vasors (622

g

Adding a Negative Reference Pin to a Port.

1. Next, choose Pick and select a "highlighted" shape on the Allegro board to create the pin .
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Available Shape Selections on the Allegro Board.

Once selected the pin name will appear in the RefDes. Pin: section as shown in RefDes Pin Name.

Add & negeties reberence pin to pord Pick
O Mt GHD W Fimpact

LD EN oI M onD e GHD W 905 38 3079 25 b Apply

RefDes Pin Name

1. Select Apply to add the new pin to the port.
The new pin and its properties now appear in the Port List as shown in .New Pin Added to Port List.

= v P Port 001 CLET+ A2 -~

For ruamber 001

Fort name CLET+ A2 1

Por smpedancs; S0 000 + 000D Ohm

] ':,1'.-: M- kb sl s

Diearmbeddrg colfsat bLA

=.U'.|"n'E' qEIEIE'\.E F'n'.

Hepgalre Releence Ping

= [B= Pinc MorDewRelPir GMD_V_908 3 37325
& Ot GHD
gt
b

e eeee

P puasition [soy) = (305 28 30749 25]
Ml orrmrburn P poshon [oy) = (906 38 3079.25)
& Laysr Marns: ETCH/TOP
# 0] Port 002 CLE1+LIZ31
+ #03 Port 003 CLKY-R22
# %I Port 004 - CLK1- U232 e
| Add | Edit

L 4
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New Pin Added to Port List

 Note

It is import to remember to update/verify the port after adding the pin.

Saving and Loading States
Once you've selected the Nets of interest and completed configuring their port properties, you can save this state or

configuration to a file for later use or further testing.
To do this, from the Allegro main menu select Export To ADS > Setup > Save State...

Expart To ADS Qgl=]

Setup ..,
Select Traces ..,

Save State ...

Load Stake ...

Save State Dialog.

This opens the Save State dialog, shown in

#_ Save State

Save bs
L]

|cds_ru:uuted1_state

What to Save

Setup Data Select Data

Save Cancel

Save State Dialog

Using this dialog you can choose to save either the setup data, selected data of your designs internal state, or both by

picking the appropriate check box.
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wihat to Save

[«] Setup Data [+] Select Drata

This enables you to change the export settings and return to a prior state without losing setup or configuration
information.

In the same way you can reload previous setup information by choosing Export To ADS > Setup > Load State... **
from the Allegro PCB Editor main menu.
This opens the Load State dialog, shown in Load State Dialog.

# | pad State

State Mame

|Ia$t_setup_state E]

YWhat to Load

[«] Setup Data [«] Select D ata

Load State Dialog

As with the Save State dialog, you can choose to load either the setup data, selected data of your designs internal
state, or both by picking the appropriate check box.

Both the Save and Load State dialogs enable to choose the name and location of the file using a standard Windows file
browser mechanism

Export to ADS

The final step is to save the selected design in EGS Archive format for export.

To save the design, choose Export to ADS > Export . There are 4 options to choose from when exporting the design to
ADS.
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Setup ...
Select Traces ...

Eopor

et R Export All &5 ...
ate
Export Selected
Export Selected Az .,
Export All

Automatically saves the entire board. This selection creates the output files and automatically puts them in the
directory where the board file resides. The exported EGS filename will be the same as the board name with the
extension _a , and no suffix. For example, if the board name is cds_routedl then the exported filename will be
cds_routedl_a .

Export All As...

Saves the entire board, but enables you to choose the name and location you wish to save the design to.

Export Selected

Automatically saves selected features or components of a design. As with Export All, this selection creates an output
file and automatically places them in the directory where the board file resides. The exported EGS filename will be the
same as the board name with the extension _a , and no suffix. For example, if the board name is cds_routedl then
the exported filename will be cds_routedl_a .

Export Selected As...

Enables you to choose the name and location you wish to save the selected area of a design to.
Once complete, an entry will appear at the bottom of the Allegro main window indicating the export was successful.

Expart log zaved in cds_routed]_a explag

Skipped facetting and continuing with anginal polygor..
Export done

E- SHAPE boundary may not crozs itzelf,

Command »

 Note

Errors appearing below the export success information indicates that the Allegro merge operation failed.
However, code has been added to work around those failures, so they can be ignored.
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Export to ADS Settings

The settings displayed in the settings dialog inSetup...". are completely configurable by the user.

B sei Lip for Momentum E| =] E|

Export Setting |Ssmple S=tbimg A w

Selection Descy

cigmal v

The list of settings displayed is the concatenation of the contents of simulation Settings defined in 3 files:

e The value of the users environment variable EEMOM_GLOBALOPTIONSFILE or
$HPEESOF_DIR/ial/config/eemom.option if EEMOM_GLOBALOPTIONSFILE is not set

e ~/pcbenv/eemom.option

e < boardDirectory >/< boardName > .option

 Note

The content of the files is actually a independent lisp list, (e.g., it has the format (mnemonic [<name>]
<definition>))

° mnemonic defines what will be defined

° some mnemonics need a name, others do not

° <definition> is a sequence of values or independent lisp lists
The files are read in the order given above.
In case of duplicate settings,(i.e., settings with the same name), the last setting found will be retained. If
the mnemonic does not have a name the contents are concatenated.
Every file, of this type, must start with (setupData and no blank lines, spaces or comment lines are
allowed before these tokens. Aside from this, empty files will also generate errors.

The following is an example of the eemom.option file used to setup the Export Settings list. This file can be
modified to your particular needs or specifications.

(Iset upbat a
; menonic to mark the start of the setup |ist
(scratchLayer Nanme " MANUFACTURI NG EEM _SCRATCH')
; nane of a class/subclass in the allegro board that can be
used as a scratch layer for the ADS integration for e.g.
storing the cutter shape ... should not belong to the edge
cl ass
(simul ationSettings
start of list of settings available to choose fromin the
; setup wi ndow
(setting "Sanple Setting A"
; nane that is displayed in setup dialog drop-down conbo box
(description "This Description is viewable in setup dial og"
"This will be displayed as the second |ine"
"And this is the third Iine"
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"Do not use special escape characters as \n \t")
di scription displayed in the setup dialog, 1 string/line
(options
(negati veMasksToStrip "FALSE")
det erm nes how to handl e negative masks
; flag: false - negative nasks -> slots
; true - negative masks -> strips
(egsAr cResol ution 22.5)
; arc facetting angle used when translating Allegro arcs
; into the output EGS file
; float: (0 < deg < 90) arc resolution used for export
; only for arcs not dealt with in signal or ground
; refacetting step
; nil: use 22.5 degrees
(egsM nEdgelLengt h 0. 000)
; mnimum edge | ength of segnents witten into the output EGS
; file (smaller segnents are conbined until the threshold is

; reached
float: (>= 0) mn edge length in the egs file
; nil: use 0.999999 times the |ayout resol ution

(egsExport Resol uti on 1000)
; int: > 0 preferably a nmultiple of 10
; if not specified, the allegro native resolution will be used

(ski pG obal Handl i ng " FALSE")
; determnes the strategy to use when preparing the sel ected
; objects for export to EGS
; ski pd obal Handl i ng does not have any effect for negative
; masks when negativeMasksToStrip "TRUE'" as this option
; requires global handling
; flag: true perform bool ean operations |ocally
; fal se perform bool ean operations globally
(gndHol eDr opDi st ance 0.0)
; determ nes how to handl e voids in the RF ground shapes
depending on their distance to Signal net features they can be
ski pped fromexport in the egs file
; float: (>=0.0) voids further away are dropped formthe egs export
; nil or (< 0.0): keep all holes
(cutter Def i nesCr ossi ngGndHol es " TRUE")
; determ nes how hol es/voids in RF ground shapes are threated
; either as voids with respect to the shape of the board or as
; voids
; With respect to the cutter shape.
; flag: false: only real holes in the original shape are considered
; for hol e renoval
; true: the cutter shape is used to define potential holes in
; a shape for renoval
; Note: when true the cutter outline is followed outside the board
; outline because this area is essentially also a void regi on
; with repect to the cutter.
; | f board shape nust be mmintained use either the false
; setting which is |less agressive or nodify the cutter
; shape to stay within the board boundary.

(gndOpt
(viaType "asDefined")
det erm nes how the viashapes will be translated in the output
shape

; string enum "asDefined"
; "square"
; "di anond" (i.esquare rotated by 45 deg)
(padType "asDefined")
; determnes how the pin and via pads will be translated in the
; out put shape
; string enum "asDefi ned"
; "square"
; "di anond" (i.esquare rotated by 45 deg)
(arcResoI ution 15.0)
; arc facetting angl e used when translating Allogro arcs
into the output EGS file
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; float: (0 < deg < 90) arc resolution used for export
; (<= 0) do not refacet arc
; nil: use 22.5 degrees
(m nEdgelLengt h 0. 000)
m ni mum edge | ength of segnents witten into the output EGS
file (smaller segnents are conbined until the threshold is

reached
float: (>= 0) mn edge length in the egs file

if arcResolution <= 0, this setting is ignored
i aTf AreaRatio 1.0)
mul tiplication factor for vias when translating the original
shape into the new one. Currently this factor will only
work correctly for circles to square or dianond
. 0000000000000000 del et e shape
0. 7978845608028653 e.g. circle -> inner square
0. 8862269254527580 sane perineter (if circle->square)
1 0000000000000000 sanme area

nil: wuse 0.999999 the | ayout resolution
i

—~
<

o

; . 1283791670955125 e.g. circle -> cricunvent square
(padeAreaRat io 1.0)
; sane behavi or as viaTfAreaRatio but for pads instead of vias
(sinplifyThermal "TRUE")
; on negative layers only, for the connections to shape strutures
. pl anes
; TRUE : do not generate thermal relief pad pol ygons
; FALSE : generate thernal relief pad pol ygons
(exportPads "connected")
string property describing which "catch" pads
wi I| be generated in the egs output for pins and vias

; “all" : (default) generate all regular pads in the output
; "none : no pads are generate except the ones on outer
; | ayers
"connected" : only if a regular connection other than a via
; exi sts
)
(si gOpt

; sane options as in the gnd opt subsection but now for shapes
bei ng defined as signal traces
(vi aType "asDefined")
(padType "asDefined")
(arcResol ution 15.0)
(viaTf AreaRatio 1.0)
(padTf AreaRati o 1.0)

) ; end of setting "Sanple Setting A"
)
(drill Props
)

currently not used

)

Importing and Using Allegro DFI Files into ADS

This chapter discusses how to import and use the files created with Allegro Design Flow Integration in ADS.

Importing Allegro DFI files in ADS Using the Import_Allegro Design Kit
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Importing exported files from Allegro Design Flow Integration in ADS has been simplified through the introduction of
the Import_Allegro Design Kit version 1.5 .

This Design Kit can be downloaded from the Agilent Knowledge Center, select EEsof Knowledge Center > Examples >
Support Examples > ADS > Layout

Import_Allegro Design Kit for the Allegro Design Flow Integration

To install the design kit, or for more information about ADS design Kkits, refer to the Design Kit Installation and Setup]
manual.

Using the Import_Allegro Design Kit

To import the exported Allegro files using Import_Allegro Design Kit do the follwing:

1. Open a new ADS layout window, select Allegro Tools > Import Allegro Layout .

% [ ALLEGROTIST PR | untivked! (Layou):4

> &

(D (i» il is

bt Lridey T gty g D Emrs

2. This opens a file browser window. Go to the export directory and select the < boardfile >. ads, click OK .
lallegrolink-3-1-02.gif!

This opens an Allegro importstatus window, as shown in Status Window. Click OK to dismiss the dialog and load the
board.
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Status Window

This loads the exported EGS layout, the Momentum substrate definition and the exported ports and associated pins,
as shown in Importing and Using Allegro DFI Files into ADS#1115899.
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All pins are Momentum internal or ground reference pins. The internal pins have the port humber of the port on the

Allegro side. The pin/port numbers above the highest exported port humber are the Negative Reference pins (these
are ground reference pins in ADS).

Two properties are attached to each imported ADS pin:

e allegro_pin : This provides the component instance.package pin number.
e allegro_net : The provides the name of the Allegro net.

Importing Allegro DFI Files Using ADS Import

This section discusses how to import the files created with Allegro DFI into ADS.

1. Start ADS and create a new project.
2. Open a new Layout window.
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3. From the Layout windows main menu select File > Import . This opens the Import dialog.

B Import:2

File Type

EGS Archive Format » | More Options...

Irpart File Mame [Source)

share'pebexamplesiboard_designcds_routed]_a Browse. .

Layers File Hame

layaut. lay Browse...
Cancel Help

Select EGS Archive Format from the File Type dropdown list on the Import dialog and use the Browse button to
select the layout file created in Allegro.

 Note

The filename will be the same as the board name with the extention _a, and no suffix (e.g., cds_routedl_a).

4. Click OK to import the file into ADS.
A Status window will open indicating a successful translation has occurred.

47




Advanced Design System 2008

I Status

Adding layer name "ETCH_WCC", index = 3
Adding laver name "ETCH_BOTTOM", index = 4
Adding laver name "DRILL_THROUGH", index =5
Adding layer name "DRILL_1_2", index = &
Adding layer name "DRILL_Z_3", index = 7
Adding layer name "DRILL_3 4", index = 8

Irpart defined O new layers in layaut lay
Tranzlation successful o

4 >

»

ok

5. Click OK to dismiss this dialog. The imported design is nhow available in the ADS Layout window.
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6. From the ADS Layout window's main menu select Momentum > Substrate > Open...
7. This opens the Open Substrate dialog. Select No to "Open a supplied substrate?"

I Open Substrate: 2

?r/ Open a supplied substrate?

Tes Mo Cancel Help

A dialog will open enabling you to choose a substrate file as seen in Open Substrate Dialog.
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Open Substrate:2

Look, in: |_jl network s ﬂ I':'_bii '

cds_routed1.slm

| )

| 1]

1 [v]
fa ] !
=

=

Deszkiop

W2

by Documents

@

by Computer -
A0047TH3

My Metwork. File name: cds_routed]. slm ﬂ Open |
Flaces
ﬂ Cancel

Filez of wpe: *zlm

Open Substrate Dialog

1. Select the substrate file and click OK .

& Note

The filename will be the same as the board name with the extension .slm (e.g., cds_routedl1.sIm).

2. If the substrate opens successfully, an Information Message dialog will open. Click OK to dismiss this dialog.

B Information Message: 2

i | Substrate cds_routedl has been successfully opened
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Verification

The following steps can be used to verify that the file information exported from the Allegro Design Flow Integration
tool was successfully imported into ADS.
For this example, the substrate file contains the following board layers:

e ETCH_TOP

e ETCH_BOTTOM
e ETCH_GND

e DRILL_THROUGH

 Note

For more information on selecting layers in Allegro, refer to Using the Layer Select Tab.

1. For this example, to view the Etch/Top layer select ETCH_TOP in the Layers dialog and de-select the other layers
associated with the imported design.

Lavers Options  Help

Current entry layer

dielz

Sel Vis  Lavers

o
Ercr_onn
ETCHVEE |
Eer_eoTTo
DRILL_THAL
BRILLIZ |
DRILLZ3 |
DRILLZ4 |

a5 | NS | oav | Wy | Edi. |

<
< <

< 1
< %

T 1T 1T 1 1 T
I O I N B

-

cds_routed] (Layouk)

The ETCH_TOP layer should now be visible in the Layout window.
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2. To view the Etch/Bottom layer, select ETCH_BOTTOM in the Layers dialog and de-select the other layers
associated with the imported design.

EEX

& Layers

Layers

Cptions  Help

Current entry lawer
diel2

Sel Wiz Layers

W v |momentum_err

v |momenturn_bos
rnamenturm_ref
ETCH_TOF
ETCH_GHD
ETCH_WCC
ETCH_BOTTO
CRILL_THRAL
CRILL_1_2
DRILL_2_3
CRILL_3 4

A5 | WS | AV NV

cds_roukedl (Layouk)

A

Edi...

The ETCH_Bottom layer should now be visible in the Layout window.
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3. To view the Etch/Gnd with Drill_Through layers, select the ETCH_GND and DRILL_THROUGH in the Layers dialog
and de-select the other layers associated with the imported design.

& Layers g

Layers Options Help

Current entry layer

diel2

Sel Wiz Lapers

rmomentum_err

momentum_bo

rnomenturm_ref_

ETCH_TOP
v v [ETCH_GND £
ETCH_VCC
ETCH_BOTTO S
v v |DRILL_THROL
DRILL_1_2
DRILL_2_3
DRILL_3_4

A

A5 1 W5 | oAV | NY Edit...

cds_roukted] {Lawvout)

The ETCH_GND with Drill_Through layers should now be visible in the Layout window.
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4. To check the layers information imported from Allegro, select Momentum > Substrate > Create/Modify... from
the ADS Layout windows main menu.

m Window DesignGuide  Help

Enable RF Mode 22 ol §

Substrate * Qpen...

Port Editor. .. Save

Box - Wavequide Save As, .,

Component r Delete, ..

Mesh r Create/Modify. ..

Simulation r Update From Schematic

Opkimization k

Post-Processing B Precompute. .
Summary., ..

30 EM K |

This brings up the Create/Modify Substrate dialog with the imported information. The Substrate Layers
information is shown below.
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Create/Modify Substrate:5

Substrate Layers | Lapout Layers ]

Marne: cds_routed]

Select a substrate laver to edit OF define a new layer:

Substrate Lapers Thickness Substrate Layer Mame
AlR_(] 2 mil | FR-4_3
FR-4_1
FH-4_ Perrmittivity [Er) Permeability (L]
._I |F|E, Lass Tangent j |HE, Lozz Tangent ﬂ
Real Real
[45 i
Lozz Tangent Lozs Tangent
add | Cut | | 0% 5

k. | Cancel Help

5. To view the layer mapping information imported from Allegro, select the Layout Layers tab in the
Create/Modify... Substrate dialog window.
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Create/Modify Substrate:5

Substrate Lapers  Lavout Layers l

X]

Select a lapaut laver ta map to the substrate
Laver Mapping Layout Layer
Subsztrate Lapers
— Name [ETCH_TOP -
FR-4_1  WIA4DRILL_THROUGH DRILL| ~ Medel | Sheet [No Expansion] -
------- SLOT ETCH_GMD
FR-4_2 WIADRILL_THROUGH DRILL, Thickness : -
------- 5LOT ETCH VT 1.2 LI
FR-4_3  WIADRILL_THROUGH DRILL, . -
------- STRIP ETCH_BOTTOM Material |Conductor (Sigmal -
AlR_4
— Real |5.959E +007 | Siemenzm j
Imag 0 | Siemenzdm ﬂ
21
=1 e
Overlap Precedence 1 = 1 .
Irfo
Layout layer mapped az STRIP
- bodel: zingle lavered zheet conductar
s by - Matenal: conductor [frequency dependent lozs]
| | | Unmap |

aF. Cancel Help

Before a physical simulaiton can be run, you still need to define the ports and the frequency plan from within the
ADS framework. For more information on defining ports and setting up a frequency plan, refer to the ADS
"Momentum" ] manual.
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